
SHOOTER TRAINING SYSTEM

SCATT MX-02 
USER MANUAL

Please read this manual to its end 
to secure safety and best quality 
of the system’s operation.

SCATT company
Tel: +7 (499) 5049374
e-mail: info@scatt.com
www.scatt.com

 SCATT company  all rights reserved.



Dear Customer, thank you for buying this system. Please read this manual to its end
to secure safety and best quality of the system’s operation.
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SCATT MX-02 accessories

Please check and identify all supplied accsessories

1. Optical sensor MX-02S

2. Mounting parts set (mounting prism with screws,
    mounting plate with screw, 2.5 mm allen key)

3. Iris diaphragm

4. Optical sensor interface cable

5.  Software CD or Flash drive

6. User guide
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Инструкция 

User G
uide

Software installation

Before using SCATT system, you need to install SCATT drivers and software.

Insert disk or flash drive (provided in a set) in the CD-ROM drive or to USB port of 
your computer, select SCATT. EXE icon in the disc drive window and follow 
instructions on the screen (fig. 1). 

Install SCATT program and drivers first, then attach your SCATT device to the 
computer.
 

While all necessary software is included on CD, we recommend to download latest 
versions of software from https://www.scatt.com.

Fig. 1

System installation
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Optical sensor MX-02S

1 - Optical sensor MX-02S
2 - Adjustable lens
3 - USB connector
4 - Distance scale pointer
5 - Lens position fix. screw
6 - USB A - mini B cable
7 - Distance scale (in meters)
8 - Iris diaphragm*

This sensor model is equipped with an adjustable lens and allows train at various 
distances.

Before use, please adjust sensor on the real distance to the target, loosen the screw 
5 and turn lens 2 so that the pointer 4 coincides with the desired division on the scale 
7, and then again tighten the screw 5.

*Mount this part on the lens for outdoor practice with strong sunlight conditions.

Connect optical sensor model MX-02S to USB port of your computer by standard 
USB A - mini B type cable (included with your kit). 

Optical sensor MX-02S installation

Installation options:
 
• Mounting the optical sensor on the 
  barrel or gas cylinders using the 
  mounting prism and plate with screw

• Mounting the optical sensor on short 
  barrel pistols using barrel inserts of 
  various calibers

Optical sensor MX-02S installation

Installation sensor on the barrel

1 - Optical sensor
2 - Mounting prism
3 - Mounting plate with screw
4 - Barrel of a gun
5 - Barrel insert (not included in a set)
6 - Short barrel pistol
7 - Fixing screw
8 - Iris diaphragm
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When hardware and software installation is over, select SCATT icon in a program 
manager to start the program (fig. 2).

Operating SCATT / Basic operations

Starting SCATT 

Fig. 2

Target

Fig. 3

*SCATT program allows you to shoot or simulate shooting at distances up to 1000 meters. 98

To start training, push “Start practice” button or select “Start practice” in “File” menu.
In the dialog box (fig. 5), select exercise, type name of shooter and press "Start" 
button.

Fig. 4

In this window (fig. 4) you need to select the exercise (target and simulated distance) 
and enter the distance to electronic target and then click "Print" button.
The printed target will correspond in scale with the distance to simulated target.

ATTENTION, to help the MX-02S sensor recognize the target better, we recommend 
to print paper target without scoring rings.

Shooting exercise

Distance to electronic target

Target preview

Open/close viewing area button

New practice  starting

Operating SCATT / Basic operations

To work with a trainer on the actual distance*, you can use a real paper target or a 
electronic target system. If you intend to use your simulator at a reduced distance, 
such as your home, you need to print out  a paper target, corresponding to the 
desired distance, and exercise. 

For indoor practice target must be evenly lit with about 1000 Lux (We recommend to 
use a LED lamp with “warm” specter 2700K or usual halogen lamp).

To print a custom paper target, connect printer to your computer and select 
“Print target” option in “Tools” menu of the SCATT program control panel (fig. 3).

Enable / Disable scoring rings printing
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Fig. 5

Shooter Name

Shooting exercises

Optical sensor calibration

After you clicked on "Start" button,  SCATT calibration window will open. In this
window (fig. 6) you need to calibrate the optical sensor (to match the axis of the 
optical sensor and sights) and make necessary adjustments.

The program allows you to automatically calibrate the sensor relative to the sighting of 
weapons, so there is no need to adjust the sights of weapons. Sensor automatically 
compensates for the “blockage” of weapons!

Optical sensor contains high frequency ceramic microphone which registers the click 
of your weapon triggering mechanism.  

To make optical sensor calibration, aim at the target and make one blank shot. 
Aiming point should be displayed inside the work area*.
 
Calibration window will close automatically after the shot. 
SCATT program will interpret your shot-hole as center of the target form.

If sensor doesn’t respond to trigger click (calibration window was not closed), please 
reduce the trigger response regulator value.

Operating SCATT / Basic operations

Fig. 6

Optical sensor 
aiming point

Working area

Aiming point
displacement

indicator

Trigger response level regulator

Operating SCATT / Basic operations

Ultra sensitive trigger mode - use it to increase the shot detect sensitivity.

Filter foreign shots - to ignore shots from the neighbor.

Preview mode -  use this mode (fig. 6a) for locate the target and adjusting of optical 
sensor position in case of aiming point indicator is not displayed (In this mode sensor 
is not register the shot).

50Hz / 60Hz - power frequency selector (to reduce influence of flickering lamps).

*If the aiming point does not get inside the work area, check the sensor’s axis is 
parallel to the axis of the barrel or try to compensate parallax by using adjusting 
screws on the mounting prism. 

1 - Gun’s barrel
2 - Mounting prism
3 - Adjusting screws
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Practice window (sighting mode)

Fig. 7

Fig. 8

Shot list

Mid-point of aiming

Shot-hole

Aiming trace

Sighting mode indicator

When you aim at the target, your aiming trace (movements of your aiming point) will
be displayed in real time, the click of triggering mechanism registers as a shot.
Program calculates shot-hole position and displays it on the target (by using aiming 
trace speed and ballistic coefficient).

After the shot you can replay of your aiming trajectory and shot result.  

Shot list contains targets with grouped shot-holes (default grouped by 10) and 
information about each shot (result, aiming time, aiming trace length and etc.).

Use electronic corrections

You can use computer mouse to make shot-hole position correction.
Move mouse pointer on the last shot-hole (it takes form of palm) and pressing left 
mouse button, drag the hole to the desired place (fig. 8).

We don’t recommend use of electronic corrections in case the shot-holes are 
grouped further than the 8th ring. In this case it is best to repeat sensor calibration.

When you are satisfied with the sighting shots results, you can move to “Match” 
mode. Press “Match” button on the control panel.

Shot-hole

Corrected 
shot-hole

Control panel

Group mid-point

Target area

Operating SCATT / Basic operationsOperating SCATT / Basic operations

Fig. 6a

Preview of optical sensor 
capture area

Turn the adjusting screws on the mounting prism to change angle of optical sensor 
alignment from the barrel axe and use “Preview mode” to control it’s position.

Calibration window may be opened at any time by pressing of “F2” button on the
keyboard of your PC.
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Practice window (match mode)

In “Match” mode (fig. 9) all features of program is available. 

Fig. 9

Scaling the target

During training you may need to change the scale of the target is displayed on the 
screen. You can change the scale of the target by pressing the numbers keys 
(1 through 0) on your keyboard, pressed numbers correspond to the target score 
rings. 

It is possible to change target scale by double-clicking on select score ring area, by 
pressing right mouse button you can reset scale.

Also you can change scale of shot list group targets by pressing “Ctrl” + “1 to 0” 
number buttons.

You can move on-screen area with mouse while holding down left mouse button and 
“Ctrl” key on your keyboard. 

Also possible to increase rectangular area on the target by selecting it while holding 
left mouse button.

For ease of analysis, after shot aiming trace is drawn in different colors corresponding 
to various time intervals:
 Green - when you start aiming•
 Yellow - one second before shot•
 Blue - 0.2 second before shot•
 Red - after shot•

Control panel

During training shooter can control some functions of the program, using the control 
panel (fig. 10)

Fig. 10

Fig. 11

Fig. 12

Contents of “File” menu

Switch display mode 
to series of shots

Sound On/Off

Contents of “Edit” menu (fig. 11).

Contents of “Shooting” menu (fig. 12).

Operating SCATT / Basic operationsOperating SCATT / Basic operations



Operating SCATT / Basic operationsOperating SCATT / Basic operations

1716

Fig. 13

Fig. 14

Fig. 15

In “View” menu (fig. 13) you can select display mode (simple or advanced) of the 
program, change menu language.

Contents of “Tools” menu (fig. 14).

Contents of “?” menu (fig. 15).
In “Help” tab, you can get information about some aspects of the program.

Saving training results

SCATT program automatically save shooting results in the directory where the files 
are grouped under the name of exercise and names of the shooters.
You also can print out training result.

Opening saved result

To open saved result slect “Open” in “File” menu of toolbar or press “Open” button.
In opened window (fig. 16) select exercise, shooter name, shooting file and press 
“Open”.

Fig. 16
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Elliptical factor (for shots): it is a ratio of averaged shot dispersion diameter on x-axis 
to that on y-axis. 
Elliptical factor (for tracings): the same as above but for tracings drawn on the target. 

Fig. 17

Distance between aiming point and the center of the target for the selected shot 
(fig. 18). 
Three curves are drawn (vs. time) in the graph: 
absolute distance from the center 
distance from the center along the X-axis (axis of abscissas) 
distance from the center along the Y-axis (axis of ordinates) 

Distance curves

Additional features of the program

Not only can you see the results of your shot after it has been taken but you also 
have the opportunity to see what is happening while you are actually aiming at the 
target. The Scatt system was developed to assist shooters from all over the world to 
enable them to reach their highest goals. 

It helps to develop a shooter's ability to achieve very high scores in shooting 
competitions, which in sport shooting is the primary objective. A series of easy to 
understand graphs enable you to assess exactly what happened, what your problems 
are and the best course of action to take. 

Some program features are not available in the "sighting" mode. To activate all 
features, switch program to “Match” mode.

General Info

This screen (fig. 17) shows the general information about the shooting file, as well as 
the loaded model. This is the place where you type in the shooter name and 
comment. The following items are displayed: 
Shooter name 
Comments 
Shooting event name 
Date and time of the first match shot 
The number of match shots. 
Integer result. 
Fractional result (all shots are scored as in final). 
Averaged shot result. 
Result for the shot group in relation to the center of the target 
Total shooting time: an interval from the beginning of first shot to the end of last shot. 
Average time for a shot. 
Stability of time interval between each shot (if all shots are equally spread the stability 
is 100%). 
Diametrical dispersion: a center-to-center distance between two most distant shots. 
Stability of aiming: average points of the tracing are taken for a given interval of time 
before the shot, and the diametral dispersion of these points is calculated. 
Accuracy of shooting: the average point from the points described above is calculated 
and its distance from the center of the target is measured. 
Average steadiness in 10.0: shows the amount of the final analysis ( control ) time up 
to the moment of shot release that the aiming point was within the 10.0. It is 
expressed in percentages. 
Average length of a tracing. 

Operating SCATT / Advanced functions Operating SCATT / Advanced functions
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Fig. 19

In this diagram (fig. 20) the dependence of shooting result on the moment of shot 
release is displayed. The plot shows what the result would have been if the shot had 
been released at some earlier moment. 

Shift curve

Operating SCATT / Advanced functions

Fig. 18

The term co-ordination (fig. 19) means the ability of the shooter to choose the optimal 
moment of shot release within his ( her ) ability of holding steadiness. This is one of 
the most important criteria by which the shooter's ability as a competitor can be 
judged. This ability to choose an optimal moment of final shot release can partly 
compensate for insufficient steadiness.
 
Co-ordination is analyzed by averaged curve of the values of                                     , 
It is plotted in some time interval prior to the shot. The value of R(t), and in particular 
the character of the change (increase or decrease) in the final 0,2-0,3 second, are 
characteristic of the degree of co-ordination ability of the shooter. The faster the R(t) 
value grows in last 0,2 second, the lower the shooter's co-ordination ability, i.e. more 
likely the aiming of the rifle or pistol becomes worse in the final moment of triggering. 

Coordination curve

Operating SCATT / Advanced functions
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Fig. 21

In the time diagram (fig. 22) the height of the bars represents the shot value and the 
distance between bars represents the time intervals between shots. This diagram 
shows parameters such as the stability of shooting rhythm. 

Time intervals graph

Operating SCATT / Advanced functions

Fig. 20

A graph of average speed of aiming point movement versus time (fig. 21). 

Aiming point speed curve

Operating SCATT / Advanced functions
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Two displaying variants are provided. In the first one the change of overall shooting 
picture with recalculating the result is displayed; in the second one the probabilities 
of a result greater than or equal to the initial result as well as an averaged one are 
drawn on the diagram depending on the growth of Dmax60. In this case, for larger 
number of random samples taken from the dispersion model, averaged figures of the 
said values are taken for each of the Dmax60 values. 
Analysis of curves drawn for several shooters allows you to draw some conclusions 
which might appear at first sight to be unexpected. Most shootings have some interval 
of the Dmax60 values, not equal to zero, in which there is high probability of reaching 
the result that is better than at Dmax60 = 0, i.e. with worse cartridges (bullets) it is 
possible to obtain better result than in case of ideal cartridges (bullets). 
The second conclusion is that it is not always reasonable to try to use more expensive 
cartridges (or bullets) since in this case the expected improvement of the result may 
not be reached. 

Fig. 23Fig. 22

Evaluating the effect of the rifle and cartridge (bullets) quality on shooting results 
(fig. 23) To test firearms and cartridges the following method is used in Russia: from a 
rifle fastened in a special bench 6-8 series of shots ( ten shots per series ) are fired. 
In each series of shots the distance between the centers of two most distant shot 
holes is determined (the Dmax10 value). The worst (maximum) value of Dmax10 of 
all the series of shots is considered to be characteristics of quality of the rifle and 
cartridges. The Dmax60 value for all 60 shots fired to the same target is the second 
characteristics. In accordance with this method the Dmax10 and Dmax60 values for 
electronic-optical training systems may be taken equal to nil. By selecting a bullet 
dispersion model in the program and changing the Dmax60 value in the program it is 
easy to estimate the effect of rifle and cartridge quality on shooting result. 
An opportunity to show the above method is available in the SCATT training system 
software. The bullets dispersion model is based on normal (Gaussian) distribution 
function (as a first approach), and it allows the change of Dmax60 value with small 
increments. 
Sampling (from the model) is performed according to random law. 

Probability graph

Operating SCATT / Advanced functions Operating SCATT / Advanced functions
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Compare two training

To compare two training, during analise saved shooting file, select “Open model” in 
“File” menu or press “Model” button on the toolbar. SCATT catalog will open. Select
file for compare and press “Open” button. 
Models information will be displayed on graphs by red color (fig. 24).

Model information is available on following graphs:
• Info
• Distance
• Coordination
• Shift
• Speed

Operating SCATT / Advanced functions Operating SCATT / Advanced functions

Fig. 24

Coordination curve

Model

Options menu

In this menu (fig. 25) you can change some parameters of program.

Fig. 25
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Troubleshooting

Short keys

New practice
Open file
Print practice results
Save practice results
Help menu
Replay aiming trace
Info menu
Target with trace
Distance graph
Coordination graph
Shift graph
Speed graph
Intervals graph
Probability graph
Full screen mode

Ctrl + N
Ctrl + O
Ctrl + P
Ctrl + S

F1
SPACE

F4
F5
F6
F7
F8
F9

F10
F11
F12

Software reports
“SCATT device not fund”

No signal from optical sensor

When optical sensor 
enters the target area,
it results in a spontaneous
shot

Make sure all SCATT units are connected to 
the computer, SCATT drivers are installed

Perhaps target is not well lit, distance to electronic 
target has been selected incorrectly. 
Check all connections, re-calibrate optical sensor, 
restart SCATT program.

Adjust trigger response sensitivity of optical sensor

If given recommendations don’t help solve your problem, consult the Service Center.

Service

Clean this device with soft dry cloth. If the surfaces are too dirty, use soft cloth, wetted
in suds or in mild soap detergent solution. Never use solvents or petrol to clean the 
device.

Specifications

Optical sensor weight:

Operating temperature range: 

30 g

o-25 to +55 C

 NOTE

Specifications can be modified by manufacturer without being worded in this manual.
Weight and dimensions are approximate.

Operating SCATT / Advanced functions

Shots parameters menu

In this menu (fig. 26) you can change following parameters:
• Bullet dispersion - changing this parameter, you can add value to the existing spread 
  of fire to assess the result of the real picture, you can get using a bullet with a known 
  value of the scatter
• Shot moment - changing this setting you can see what would result if the shot 
  occurred before or after a while
• F Coefficient - ballistic coefficient (angular velocity multiplied by the flight time)
• Control interval - time before shoot for which analysis is based
• Coinside grouping with the center of the target - trasfer center of your shot holes 
  group to center of the target.
 

Fig. 26
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